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AHGW Pro 1.0 Tutorial 

Building 3D Models with the Horizons Method 
From cross sections and rasters to GeoVolumes 
 

 

Objectives  

Learn how to use the Arc Hydro Groundwater Pro to manage subsurface data and create 3D 
representations of hydrostratigraphy.  

 

Prerequisite Tutorials 

 None 

Required Components 

 ArcGIS Pro 

 3D Analyst 

 Subsurface Analyst 

Time 

 30–50 minutes 

 

AHGW Pro 1.0 
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1 Introduction 

Arc Hydro Groundwater Pro (AHGW Pro) is a geodatabase design used for representing 
groundwater datasets within ArcGIS Pro. The data model helps to archive, display, and 
analyze multidimensional groundwater data, and includes several components to 
represent different types of datasets, including representations of aquifers and 
wells/boreholes, 3D hydrogeologic models, temporal information, and data from 
simulation models.  

The Arc Hydro Groundwater Pro Tools help to import, edit, and manage groundwater 
data stored in an AHGW Pro geodatabase. This tutorial illustrates how to use the tools to 
manage subsurface data and create 3D representations of hydrostratigraphy. A basic 
familiarity with the AHGW Pro data model is suggested, but not required, prior to 
beginning this tutorial. 

1.1 Outline 

This tutorial works with simplified subsurface data from Roseville, California. The 
following tasks will be discussed and demonstrated: 

 Create section line features. 

 Explore the concept of horizons in a mosaic dataset. 

 Create GeoSection features. 

 Explore the Clip and Fill options when creating GeoSections and GeoVolumes. 
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 Create GeoVolume features. 

The XMS Wiki has more information about the Groundwater Data Model
1
 and horizons, 

clip, and fill attributes.
2
 

1.2 Required Modules and Interfaces 

Enable the following components in order to complete this tutorial: 

 ArcGIS Pro license 

 3D Analyst (the tools in this tutorial can be run without 3D Analyst, but not all the 
data can be visualized) 

 AHGW Pro Tutorial Files 

The Arc Hydro Groundwater Pro Tools require installation of a compatible ArcGIS Pro 
service pack. Check the Arc Hydro Groundwater Pro Tools documentation to find the 
appropriate service pack for the version of the tools being used. 3D Analyst is required 
for the latter portion of the tutorial involving 3D objects. A license for 3D Analyst is 
required to view the results of the tutorial. The tutorial files should be downloaded and 
saved on a local drive. 

2 Getting Started 

To start, open the project file for this tutorial. 

1. If necessary, launch ArcGIS Pro. 

2. If on the ArcGIS Pro start page, select  Open another project in the bottom 
right corner of the window to open the Open Project dialog. 

3. If already in the user interface, use the  Open macro to open the Open Project 
dialog. 

4.  Browse to the location with tutorial files for this tutorial. 

5. Select the file “  horizons.aprx” located in the SubsurfaceAnalystPro\horizons 
folder. 

6. Click OK to import the project. 

A Map view, an XS2D view, and a Scene view appear. The map includes a boundary 
defining the extent of the 3D model as shown in Figure 1.  

                                                      

 

1
 See https://www.xmswiki.com/wiki/AHGW:Arc_Hydro_Groundwater_Data_Model 

2
 See https://www.xmswiki.com/wiki/AHGW:Horizons,_Clip,_and_Fill_Attributes 

https://www.xmswiki.com/wiki/AHGW:Arc_Hydro_Groundwater_Data_Model
https://www.xmswiki.com/wiki/AHGW:Horizons,_Clip,_and_Fill_Attributes
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Figure 1      Boundary of the 3D model 

Next, ensure that the AHGW Pro tools are correctly configured.  

7. Expand the  Toolboxes list in the Catalog pane. Check if “  
ArcHydroGroundwater.pyt” is there. If it is not there, follow steps 8-10. 

8. In the Catalog pane, right-click on Toolboxes and use the  Add Toolbox 
command. 

9. In the Add Toolbox dialog, browse to the location where the Arc Hydro 
Groundwater Toolbox files were saved. 

10. Select “  ArcHydroGroundwater.pyt” and click OK. 

“  ArcHydroGroundwater.pyt” now appears in the Toolboxes list. When using 
geoprocessing tools, it’s possible to set the tools to overwrite outputs by default, and 
automatically add results to the map/scene. To set these options:  

11. On the ribbon, select the Project tab.  

12. From the list on the left, select Options to open the Options dialog. 

13. Select Geoprocessing from the list under Application on the left of the dialog. 

14. Ensure that Allow geoprocessing tools to overwrite existing datasets and Add 
output datasets to an open map are turned on. 

The options should appear similar to Figure 2. 
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Figure 2      Setting Geoprocessing tools to overwrite outputs by default and to add results of 
geoprocessing tools to the display 

15. Select OK to exit the Options dialog. 

16. Using the  arrow in the upper left corner, return to the main user interface. 

3 Creating SectionLines 

As the first step, create a set of section line features from which the 3D features will be 
derived.  

3.1 Sketching the SectionLines  

To start sketching section lines: 

1. On the ribbon, select the Edit tab. 

2. If necessary, click  Edit to enable editing. 

The necessity of step 2 depends on the ArcGIS Pro settings on the local machine. 

3. In the Features section, click on the  Create button to open the Create 
Features pane. 

4. In the Create Features pane, select the “SectionLine” layer under the SectionLine 
heading to make the tools for lines available. 

5. Click on the  Line button to create a line feature in the Map view.  
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6. Create line A-A', as shown in Figure 3, by clicking to begin the SectionLine, then 
double-clicking to end it. Make sure the lines stay within the model domain. 

7. Repeat step 5 for lines B-B', C-C', D-D', E-E', and F-F', as shown in Figure 3. 

8. In the Contents pane, right-click on “SectionLine” and select  Attribute Table 
to bring up the SectionLine table view displaying the SectionLines just created. 

9. In the SName column on the fourth row, enter “A-A'”. 

10. Repeat step 7 for B-B', C-C', D-D', E-E', and F-F', respectively from the second 
row down. 

At this point, the map should be similar to the one shown in Figure 3. The SName values 
will not appear in the Map view. 

 

Figure 3      Section lines sketched within the model boundary 

3.2 Assigning Vertical Exaggeration 

Next, assign vertical exaggeration values to the section lines. The cross section features 
will be scaled based on the vertical exaggeration attribute. 

1. On the Edit ribbon tab, click Clear  to deselect all rows in the table. 

2. Right-click on the Vertical Exaggeration column header and select Calculate 
Field… to open the Calculate Field dialog. 

3. In the VertExag2D= field near the bottom, enter “20” (without the quotes). 

4. Click OK to close the Calculate Field dialog and change the value in the Vertical 
Exaggeration column for each row. 

5. On the Edit ribbon tab, select  Save to save the edits to the SectionLine table. 

6. If  Edit was clicked above to begin the editing session, click  Edit to 
complete the editing session. 

7. Close the SectionLine table view. 
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3.3 Assigning HydroIDs 

After creating the features, assign HydroID values to them. The HydroID is the unique 
identifier of the feature within the geodatabase, and is used to create relationships 
between tables and feature classes.  

1. In the Catalog pane, expand “  ArcHydroGroundwater.pyt” and “  
Groundwater Analyst”. 

2. Double-click on “  Create Unique ID Table” to open the Create Unique ID Table 
tool in the Geoprocessing pane. 

3. Click the Browse  button to bring up the UNIQUEID Table dialog.  

4. In the data tree on the left, under  Project, browse to Databases and open the 
Horizons.gdb database.  

5. Enter “UniqueID” as the Name. 

6. Click Save to close the UNIQUEID Table dialog and save the name of the 
UniqueID table. 

7. For the Last HydroID used, enter “1”. 

8. Click Run to run the Create Unique ID Table tool. 

The tool creates a new table named “UniqueID” and adds it as a standalone table in the 
Contents pane. 

3.4 Populating HydroID Values 

Next, populate the HydroID values for the SectionLine features. 

1. In the Catalog pane under the “  Groundwater Analyst” toolset, double-click on 

the “  Assign HydroID GW” tool to bring up the Assign HydroID GW tool in the 
Geoprocessing pane. 

2. Select “UniqueID” from the Input UNIQUEID Table drop-down. 

3. Select “SectionLine” from the Input Features to Assign HydroID drop-down. 

4. Select “HydroID” from the HydroID Field of Input Features drop-down. 

5. Make sure Overwrite Existing HydroID Values is on. 

6. Click Run to run the Assign HydroID GW tool. 

7. Right-click on “SectionLine” in the Contents pane and select  Attribute Table 
to bring up the SectionLine table view.  

The HydroID column has now been populated. 

8. Close the SectionLine table view. 

4 Viewing the Scene 

Next, create 3D GeoSection and GeoVolume features and visualize them in Scene view.  

Begin by going to a scene of Roseville. 

1. Click the  Scene view tab. 
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The scene should appear similar to Figure 4. This data was obtained from a groundwater 
model created for the region, then modified for the purposes of the tutorial to illustrate 
concepts and protect confidentiality. There are different rasters representing horizon 
data, which will be used to create GeoSection and GeoVolume features. 

 

Figure 4      Rasters representing Horizon data 

The rasters are also organized in table format as part of a mosaic dataset. The rasters 
overlap each other and contain different attributes to describe the horizons. The rasters in 
the mosaic dataset will later be used to build GeoSection and GeoVolume features. 

2. After examining the scene, click on the arrow to the left of “Rasters” in the 
Contents pane to reveal the individual rasters: TOP1, TOP2, TOP4, TOP6, 
TOP7, and BOT7 (they may be listed in a different order). 

3. Turn off each of the six rasters, leaving “Rasters” turned on. 

4. Select “GeoRasters”.  

This is the mosaic dataset storing the same rasters representing the horizon data. 

5. Right-click on “GeoRasters” and select Open Table |  Attribute Table to bring 
up the GeoRasters: Footprint table view (Figure 5). 

Note that the table includes a Raster field for the rasters, along with a field called 
HorizonID for storing the order of strata representing the horizons. Visualizing all fields 
usually requires scrolling to the right. 

 

Figure 5      The mosaic dataset for the horizons data 
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6. Close the GeoRasters: Footprint table view. 

5 Building GeoSection Features 

The GeoSection features are an ideal starting point for creating subsurface data from 
horizons. The cross sections (or “fence diagrams”) are simpler to create and easier to 
view than the solid GeoVolume features. The GeoSection features can be used to see if 
the interpolation options applied are reasonable before building GeoVolume features for 
the entire area covered by the rasters in the mosaic dataset. 

To build the GeoSection features, one or more SectionLine polyline features is needed to 
determine where the subsurface cross sections will be created, along with a dataset 
representing the horizon data, and the multipatch GeoSection feature class where the 
new features will be created. 

5.1 Creating a GeoSection Feature Class 

The first step will be to create a new GeoSection feature class: 

1. In the Catalog pane, expand “  ArcHydroGroundwater.pyt”, “  Subsurface 

Analyst”, and “  Features”. 

2. Double-click on the “  Create GeoSection Feature Class” tool to bring up the 
Create GeoSection Feature Class tool in the Geoprocessing pane. 

3. Click the Browse  button to the right of Output GeoSection Features to bring 
up the Output GeoSection Features dialog. 

4. In the data tree on the left, under  Project, browse to the 

Databases\Horizons.gdb\ database and double-click on  Data. 

5. In the Name field, enter “GeoSection”. 

6. Click Save to exit the Output GeoSection Features dialog and save the 
GeoSection feature class name. 

7. Leave Input Spatial Reference empty.  

The Horizons.gdb\Data feature dataset has the correct XYZ coordinate systems defined. 
Because the GeoSection feature class will be placed in the feature dataset, a spatial 
reference does not need to be specified. 

8. Click Run to run the Create GeoSection Feature Class tool. 

A new feature class named “GeoSection” should be added to the scene in the Contents 
pane.  

5.2 Reviewing the GeoRaster Mosaic Dataset 

At this point, the “SectionLine” feature class layer, the “GeoSection” feature class layer, 
and the “GeoRasters” mosaic dataset layer should all be listed in the Contents pane.  

Before building the GeoSection features from the rasters, review the “GeoRasters” table. 
Do the following: 

1. Right-click on “GeoRasters” in the Contents pane and select Open Table |  
Attribute Table to open the GeoRasters: Footprint table view. 
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2. Note that the Clip and Fill columns on the row named “TOP1” both contain a 
value of “1”.  

This means that subsurface layers (which are all of the other layers) do not extend above 
the “TOP1” layer. 

The “TOP1” row in the GeoRasters mosaic dataset table comes from a digital elevation 
model (DEM) of the ground surface elevation data. Depending on the interpolation values 
used to generate the rasters stored in the mosaic dataset, there might be portions of the 
raster on the edges which exceed the ground surface elevation. 

3. Close the GeoRasters: Footprint table view. 

5.3 Running the Rasters to GeoSection Features Tool 

To run the Rasters to GeoSections tool: 

1. In the Catalog pane, expand “  ArcHydroGroundwater.pyt”, “  Subsurface 

Analyst”, and “  Features”. 

2. Double-click on the “  Rasters to GeoSections” tool to bring up the Rasters to 
GeoSections tool in the Geoprocessing pane. 

3. Select “SectionLine” from the Input SectionLine Features drop-down. 

4. Select “GeoRasters” from the Input Raster Catalog drop-down. 

5. Select “HorizonID” from the Raster Catalog Horizon ID field drop-down. 

6. Enter “1000” as the Discretization Spacing. 

7. Select “GeoSection” from the Input GeoSection Features drop-down. 

8. Select “Clip” from the Raster Catalog Clip field drop-down. 

9. Select “Fill” from the Raster Catalog Fill field drop-down. 

10. Select “HGUID” from the Raster Catalog HGUID field drop-down. 

11. Make sure Append to Existing GeoSection Features is turned on. 

12. Click Run to run the Rasters to GeoSections tool. 

13. When the tool finishes running, right-click on “GeoSection” in the Contents pane 

and select  Properties to open the Layer Properties: GeoSection dialog. 

14. Select Elevation from the list on the left. 

15. From the Features are drop-down menu, select “Relative to the ground”. 

16. For Vertical Exaggeration, enter “20”. 

17. Click OK to save the settings and close the Layer Properties: GeoSection dialog. 

The GeoSections should be barely visible now. however, the ModelBoundary layer is still 
blocking most of the view. 

18. In the Contents pane, turn off the “ModelBoundary” layer by unchecking the box 
next to it. 

The scene should have 3D features similar to those shown in Figure 6. 
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Figure 6      GeoSection features created by running the Rasters to GeoSections tool 

19. If the 3D features do not appear, click  Refresh in the bottom-right corner of 
the view. 

20. If step 19 doesn’t work, in the Catalog  pane, under Databases right-click on “  
Horizons.gdb” and select Refresh. 

5.4 Symbolizing the GeoSections 

To better visualize the cross sections, symbolize the GeoSections by the HorizonID used 
to build them. 

1. Right-click on “GeoSection” in the Contents pane, and select  Symbology to 
open the Symbology pane. 

2. On the Symbology pane, under Primary symbology, select “Unique Values” from 
the drop-down menu. 

3. Select “HorizonID” from the Field 1 drop-down. 

4. Right-click in the Value column in the list table and select Sort Descending. 

This sorts the unique HorizonID values from the highest value at the top to the lowest 
value on the bottom. 

5. As desired, use the Explore  tool to view the GeoSection features from 
multiple angles to view the results of the tool. 

The results should be similar to those found in Figure 7, though the colors may be 
different. 
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Figure 7      GeoSection features symbolized by the HorizonID field   

Next, create 3D GeoVolumes to visualize the hydrogeologic units as volume elements. 

6 Creating a Projection TIN 

A TIN (Triangular Irregular Network) is used to define the extent of the GeoVolume 
features to be created, as well as to determine the size and extent of the triangle strips 
used to define the multipatch features. The number of triangles on the TIN determines 
the amount of processing that must be done. The TIN used in the Rasters to 
GeoVolumes tool is referred to as a projection TIN, because the elevations on the TIN 
are not used, but the triangles are used only to define the shape and extent of the 
GeoVolumes. 

A simplified projection TIN has been provided in the tutorial for the benefit of those who 
do not have access to the “3D Analyst Tools” extension.  

1. Turn on the “projtin4k” layer in the Contents pane. 

The TIN should appear similar to Figure 8.  
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Figure 8      A projection TIN used for creating GeoVolume features 

2. Turn off “projtin4k” projection TIN in the Contents pane. 

6.1 Enable the 3D Analyst Extension 

A license for the 3D Analyst extension is required to create a TIN using the Polygon to 
TIN tool using the following steps. For those without the 3D Analyst Tools, please skip to 
Section 7 and use the provided “projtin4k” TIN for the remainder of the tutorial. 

If the “3D Analyst Tools” toolbox is not already enabled, do the following: 

1. On the ribbon, select the Project tab. 

2. Select Licensing from the list on the left. 

3. On the Licensing page, under Esri Extensions, check to see if the 3D Analyst row 
has “Yes” in the column labeled Licensed. 

4. If it does not, use the Configure your licensing options button to open the 
Licensing dialog and configure the license. 

6.2 Creating a TIN Using 3D Analyst 

Next, create a projection TIN: 

1. In the Catalog pane, expand the “  ArcHydroGroundwater.pyt” toolbox, the “  

Subsurface Analyst” toolset, and the “  TIN” toolset. 

2. Double-click on “  Polygon to TIN” to bring up the Polygon to TIN tool in the 
Geoprocessing pane. 

3. Select “ModelBoundary” from the Input polygon feature drop-down to set the 
polygon defining the boundary of the projection TIN. 

4. Enter “4000” as the TIN triangle spacing.  

This creates equilateral triangles inside the TIN with edge spacing equal to the value 
entered. Irregular triangles are created along the boundary of the TIN. 
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5. Click Browse  to the right of Output projection TIN to bring up the Output 
projection TIN dialog. 

6. In the data tree on the left, under  Project, browse to the Folders\horizons\ 
folder. 

7. Enter “projtin” as the Name. 

8. Click Save to exit the Output projection TIN dialog and save the output projection 
TIN name. 

9. For TIN spatial reference, select SectionLine from the drop-down menu. 

The TIN spatial reference field should automatically populate with 
“NAD_1983_StatePlane_California_II_FIPS_0402_Feet / VCS:NAD_1983”. 

10. Click Run to run the Polygon to TIN tool. 

6.3 Symbolizing the New TIN 

The next step is to symbolize the new TIN by doing the following: 

1. Right-click on “projtin” in the Contents pane, and select  Symbology to bring 
up the Symbology pane. 

2. On the Symbology pane, select the  Symbolize your layer using a surface 
tab to bring up the Surface page. 

3. Uncheck the Draw using checkbox to turn it off. 

4. Now select the  Symbolize your layer using edges tab to bring up the Edges 
page. 

5. Ensure that the Draw using checkbox is on. 

6. From the Draw using drop-down, select “Simple”. 

7. Select the  button to edit the symbol if desired. 

The TIN should appear similar to Figure 9. 

 

Figure 9      The new appearance of the TIN 
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7 Building GeoVolume Features 

Once acceptable clip and fill options have been determined and a projection TIN has 
been defined, GeoVolume features can be created to generate a 3D volume of the 
horizons data. The Rasters to GeoVolumes tool contains the same options as the 
Rasters to GeoSections tool for clipping and filling in between rasters. 

7.1 Creating a GeoVolume Feature Class 

Before creating GeoVolume features from the rasters, create a GeoVolume feature class: 

1. In the Catalog pane, expand “  ArcHydroGroundwater.pyt”, “  Subsurface 

Analyst”, and “  Features”. 

2. Double-click on the “  Create GeoVolume Feature Class” tool to bring up the 
Create GeoVolume Feature Class tool in the Geoprocessing pane. 

3. Next to Output GeoVolume Features, click Browse  to bring up the Output 
GeoVolume Features dialog. 

4. In the data tree on the left, under  Project, browse to Databases\Horizons.gdb 

and open the  Data feature dataset.  

5. Enter “GeoVolume” as the Name.  

6. Click Save to exit the Output GeoVolume Features dialog and save the 
GeoVolume features output name. 

7. Leave Input Spatial Reference blank. 

8. Click Run to run the Create GeoVolume Feature Class tool. 

A new “GeoVolume” layer should appear in the Contents pane. 

7.2 Converting Rasters to GeoVolumes 

To simplify the following steps, “projtin4k” will be used for the projection TIN. Feel free to 
use “projtin” if Section 6 was completed.  

Now build the GeoVolume features by doing the following: 

1. In the Catalog pane, expand “  ArcHydroGroundwater.pyt”, “  Subsurface 

Analyst”, and “  Features”. 

2. Double-click on the “  Rasters to GeoVolumes” tool to bring up the Rasters to 
GeoVolumes tool in the Geoprocessing pane. 

3. Select “projtin4k” from the Input Projection Tin drop-down. 

4. Select “GeoRasters” from the Input Raster Catalog drop-down. 

5. Select “HorizonID” from the Raster Catalog Horizon ID field drop-down. 

6. Make sure “1” is the value entered as the Minimum MultiPatch Thickness. 

Sections of the GeoVolume that have a thickness less than this value will not be created. 

7. Select “GeoVolume” from the Input GeoVolume Features drop-down. 

8. Select “Clip” from the Raster Catalog Clip field drop-down. 

9. Select “Fill” from the Raster Catalog Fill field drop-down. 
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10. Select “HGUID” from the Raster Catalog HGUID field drop-down. 

11. Make sure Append to Existing GeoVolume Features is turned on. 

12. Click Run to run the Rasters to GeoVolumes tool. 

The GeoVolumes should now appear as 3D features (Figure 10). However, the 
GeoVolumes vertical exaggeration has still not been adjusted to match the vertical 
exaggeration of other layers in the project. 

 

Figure 10      GeoVolume features in 3D      

7.3 Symbolizing the GeoVolumes by HorizonID 

To better visualize the results, first adjust elevation properties. 

1. Right-click on the “GeoVolume” layer in the Contents pane, and select  
Properties to bring up the Layer Properties: GeoVolume dialog. 

2. On the Elevation tab, select “Relative to the Ground” from the Features are drop-
down menu. 

3. For Vertical Exaggeration, enter “20.00”. 

4. Click OK to close the Layer Properties: GeoVolume dialog. 

Now the GeoVolume should be significantly more visible. It now reflects the vertical 
exaggeration that is used for the rest of the project. Next, symbolize the GeoVolumes by 
the HorizonID used to build them. 

5. Right-click on the “GeoVolume” layer in the Contents pane and select  
Symbology to open the Symbology pane. 

6. In the Symbology pane, click  in the upper right corner and select Import 
Symbology to open the Apply Symbology From Layer tool in the Geoprocessing 
pane. 

7. Ensure that Input Layer is set to “GeoVolume”. 

8. Set Symbology Layer to “GeoSection”. 

This means that the symbology will match the symbollogy from the GeoSection layer. 
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9. Click Run to run the Apply Symbology From Layer tool. 

The GeoVolume features should appear similar to Figure 11, though the colors may vary. 

 

Figure 11      The GeoVolume features symbolized       

10. As desired, use the Explore  tool or the navigator to view the GeoVolume 
features from multiple angles to view the results of the tool. 

The Filtering section in the Arc Hydro Groundwater ribbon tab can be used to view 
individual GeoVolume layers. To view a single GeoVolume: 

11. On the ribbon, select the Arc Hydro Groundwater tab. 

12. Select the “GeoVolume” layer in the Contents pane. 

13. Select “HorizonID” from the Field drop-down in the Filtering section. 

14. Select “8” from the Value drop-down. 

The results should appear similar to Figure 12, though colors may vary. Feel free to 
experiment by selecting different HorizonIDs or HGUIDs from the drop-downs. 
Additionally, the 3D Effects toolbar can be used to control the layer transparency, face 
culling, lightning and shading. 



AHGW Pro Tutorials  Horizons 

 Page 18 of 19 © Aquaveo 2023 

 

       Figure 12      Display only HorizonID 8 by using the Field Filter tool 

8 Using the HGU Color Manager 

The features in the GeoSection and GeoVolume feature classes are different 
representations of the same hydrogeologic units. The HGU Color Manager can be used 
to apply a common set of colors to display features tied to the same HorizonID fields. 

1. On the ribbon, select the Arc Hydro Groundwater tab. 

2. On the Arc Hydro Groundwater tab, select the HGU Color Manager to open the 
HGU Color Manager pane. 

3. Select “HydrogeologicalUnit” from the HGU Table drop-down. 

4. Select “HydroID” from the HGU ID Field drop-down. 

5. Select “HGUName” from the HGU Name Field drop-down. 

6. At the bottom of the page, uncheck the checkbox for every layer except 
GeoVolume and GeoSection. 

7. Click Apply Symbology to apply the changes. 

8. Using the Filtering drop-downs, view each of the HorizonIDs in turn.  

Notice that the colors apply to both the GeoSections and GeoVolumes. 

The HGU Color Manager has saved the selected colors (as numbers) in the “HGUColor” 
field of the “HydrogeologicUnit” table. These colors will be available for application to the 
features when using the HGU Color Manager with either a Map or Scene view. 
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9 Conclusion 

This concludes the “Horizons” tutorial. The following key concepts were discussed and 
demonstrated in this tutorial: 

 SectionLine features are sketched in ArcGIS Pro and used to create 3D 
GeoSections. 

 Horizons can be used to represent stratigraphic units. 

 Horizons stored in a mosaic dataset can be used to create GeoSection and 
GeoVolume features. 

 Clip and fill options can be used to manage the way GeoSection and GeoVolume 
features are created. 

 A projection TIN is used to define the GeoVolume features created from the 
rasters in the GeoRasters mosaic dataset. 

 The HGU Color Manager is used for managing the symbology of multiple layers 
representing hydrogeologic units.  

 


